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Follow the Dotted Line to
Improved Report Layouts
Making your reports easier to follow is an unending challenge. For reports that serve as lists,
you can improve their look and readability by using dot leaders to connect the entries in
one column to the corresponding entries in another.

By Tom Marcellus

O

PEN most phone books and you’ll notice a
dotted line between the name (or in some
books the name and address) and the phone
number. The dotted line (called a dot leader) guides
your eyes to the phone number. If you design
reports that simply list things, such as a telephone
directory or a price list, you can make them easier to
read by adding dot leaders.
The examples I’ll show illustrate how to design
a telephone directory with dot leaders between
names and phone numbers. (See Figure 1.) The first
version produces a phone list in two parallel
columns with the entries sorted horizontally across
the page, like mailing labels. To get Q&A to do this,
you’ll use a specially designed mailing label format.
The second version is a standard columnar
report with “snaking” or “newspaper” columns,
where the entries are sorted vertically down the first
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column and continue at the top of the second
column on the same page, like a phone book. Which
version you use depends on your needs.
The database
To keep things simple, I’ll illustrate the techniques
using a sample database containing the following
four fields:
First:
Last:
Phone:
Dept:

#1
#2
#3
#4

The field ID numbers from the Program Spec follow
the field names. As you’ll see, certain Q&A
limitations make it necessary to use field ID
numbers instead of field names.
Continues on page 3
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README.1ST

U

PGRADES for Q&A for DOS and Q&A for Windows are
still in the pipeline and appear to be getting closer.
Though Symantec in Cupertino, California is as tightlipped as ever about the venture (and has been known to
summarily drop projects even in advanced stages of
development), there are just too many signs and too much
activity to deny that “something wonderful is about to happen.”
Official upgrade feature lists originating from as far away as
Symantec’s facility in Dublin, Ireland are winding up in
unofficial hands. I’m looking at a recent Q&A upgrade list
prepared by a Symantec product engineer there that contains 20some new features. Terms such as powerful, more relational-like,
and added versatility spring to mind. The German-language Q&A
for DOS upgrade is due to appear any day now. I’m reluctant to
say more at this point out of concern that the plug might be
pulled or that the new release will be available everywhere
except in the country where Symantec is headquartered.
It’s still a game of wait-and-see.
While we’re waiting, we can work on making our reports
easier to follow. For reports that serve as lists, such as phone
directories or price lists, you can improve their readability by
adding dot leaders (like a phone book) to connect the entries in
one column to the corresponding entries in another. I’ll show
you a variety of ways to do it.
If your business requires advance employee scheduling, a
Q&A database can help you keep tabs on who’s assigned to
work when, as well as help you anticipate labor costs and get
valuable payroll information. Bill Halpern shows you how to
build an employee scheduling system you can modify to meet
your needs. He includes a couple of those “impossible” reports
for which he and his partner Gordon Meigs have become
legendary.
This issue also contains a feast of QuickTips and answers to
reader questions, on topics ranging from suppressing report
columns and adding a “private” field to your data entry form
(without password protecting the database) to auto-updating
related records in another database.
Bon appétit!

Tom Marcellus
Editor

The Quick Answer is looking for tips, tricks, and application techniques
that solve problems and make Q&A easier to work with. If you have
found a way to work smarter with Q&A, submit your tips or article (and
a biographical sketch) on disk in Q&A Write for DOS or Windows,
WordPerfect for DOS, of Microsoft Word for Windows. Enclose a
printout—and a daytime phone number.
Mail your submission to The Editor, The Quick Answer, PO Box
888, Kent, WA 98035-0888. Honoraria are paid upon publication.
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Dotted Line

Continued from page 1

A parallel column list
In a Q&A report you can’t sort entries horizontally
across the page, but for a simple list such as a phone
directory, you can use a mailing label format to
achieve the horizontal sort. (Even though you might
not want your phone list sorted horizontally,
learning how to do it will expand your output
options.)
From the Write menu, choose Mailing labels. At
the List of Mailing Labels screen, type in a name for
the new label design, such as Phone List, and press
Enter. Q&A will display its default label template.
Press Ctrl-F6 for the Define Label screen (see Figure
2), and make the following changes:
• Set the Width to between 3.7 inches and 4
inches.

Press Ctrl-F9 for the Font Assignments screen
and make a small monospaced font, such as Line
Printer, your default (Regular) font. This will
accomplish these three things:
• It makes Q&A give you the space you need to
type the required expression.
• It enables you to print the list in two columns on
a standard sheet of paper.
• The monospaced font (as opposed to a
proportionally spaced font) will make the
column entries align vertically.
When you’ve changed the font, press F10 to return
to the Label Definition screen. You’ll now have a
longer box with enough room to type the following
expression on one line:
*Pg {#2+", "+#1+" ("+#4+")"+
@Text(35-@Len(#2+#1+#4),".")+#3}*

• Set the Height to 1 (not 1 inch).
• Set all the margins to 0.
Press F10 to return to the Label Definition screen.
With the label size and margins you just
specified, the Label Definition screen will display a
long narrow box with room for a single line of about
40 characters. You need to lengthen that box so you
can type an expression into it telling Q&A how to
convert the label to a horizontally sorted report.

If you made your label 3.7 inches wide, the
preceding line will just fit. If you made the label 4
inches wide, you’ll have some room to spare. Your
Label Definition should now look like Figure 3.
If you’re wondering where the merge fields go,
they’re already there. You’re using this label design
to print a list, not labels, so you don’t need the usual
merge fields. Instead, you reference the fields in the
programming expression. I’ve done this using the
fields’ Program Spec field ID numbers instead of the
field names—the names would make the expression
too lengthy to fit in the allotted space. Here’s what
the expression does:
• It concatenates (strings together) the last name
(field #2); a comma and a space; the first name
(field #1); another space; and the department
name (field #4), surrounded by parenthesis.

Figure 1. Portions of two telephone directories
with dot leaders. Top: A horizontally sorted list
created in Q&A’s Mailing Labels module. Bottom:
A vertically sorted list that began as a report and
was converted to a two-column format in Write.

© Pinnacle Publishing, Inc.

Figure 2. The Define Label screen with
dimensions for the Phone List “label.”
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This produces the following format:
Thurman, Wayne (Sales)

• The expression then concatenates the preceding
name and department string with the result of
the @Text expression, giving you this:
Thurman, Wayne (Sales)............

• Finally, the phone number (field #3) is tacked
on, giving you this:
Thurman, Wayne (Sales)............213-985-6179

Because the names and departments are different
lengths, the trick is to have Q&A calculate the
number of dots required to connect them to the
phone numbers so they’ll align left. To do this, I’ve
assigned a value of 35 to the @Text function and
subtracted from that the combined length (in
characters) of the last name, the first name, and the
department. As Q&A processes the record, if the
sum of the lengths of these three values turns out to
be, say, 25 the @Text function subtracts 25 from 35
and prints 10 dots. You can adjust the 35 to print
more or fewer dots, but you’ll need to keep it in the
30 to 40 range depending on the lengths of the
names and departments and the physical page
dimensions.
When you’ve typed in the programming
expression as shown, press F2 for the Print Options
screen and make the following settings:
• Set the Space between labels to 0.
• Set the Number of labels across to 2.
• Set the Number of lines per label sheet to 66 to
print approximately 132 names and phone
numbers on a page in two columns. If you want
more space (more leading) between the rows,
set the Number of lines per label sheet to a
lower number, such as 50 or 60. If you want to
cram more entries on a page (less leading) set it
to a higher number, such as 75 or 80.
• Set the Print offset to 5 to begin with. You can
increase or decrease this setting in order to
center the list on the page. (Use Page Preview to
get a rough idea of how the page will look at
various offset values.)
• Type in the path and name of the pertinent
database on the Name of Q&A merge file line.

4
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With your Print Options set, press F10 for the
Retrieve Spec. You can leave the Retrieve Spec blank
to select all the records in the database, or you can
type in the retrieval parameter to select, for
example, just the people in the sales department.
Press F8 for the Sort Spec, type 1AS in the last
name field, and 2AS in the first name field. Finally,
press F10 to print the report. You’ll get a
horizontally sorted layout that looks like the top of
Figure 1.
A snaking column list
To produce a two-column phone list sorted
vertically (like a phone book), you’ll need to start
with a columnar report and finish by printing the
report to disk, calling it up in Write as a document,
and printing it out using Write’s multicolumn print
option. Using the same sample database, here’s the
Column Sort Spec for the Phone List report:
First:
Last:
Phone:
Dept:

1,I
2,I
3,I
4,I

For the sake of simplicity, I’ve numbered the
columns in the same order as the Program Spec field
IDs in the earlier example. The columns are made
invisible with the I command. Here’s the single
derived column:
Heading: \
Formula: #2+", "+#1+" ("+#4+")"+
@Text(35-@Len(#2+#1+#4),".")+#3
Column Spec: 5,AS,HS(\ )

The derived column is the only column that prints
and the expression used in its formula is the same as
the one used for the mailing label report. The
optional “\” command on the Heading and Column
Spec lines suppresses the column heading along
with the dashed separator line that prints beneath it.
After you’ve filled out the column specs, press
F10 for Print Options, and then press F8 to define
your page. Set your page width and right margin to
85, set your other margins to 0, and set your page
length to a value higher than the number of entries
in the report. This way, Q&A won’t break the report
into pages when you print it to disk.

Figure 3. The programming expression typed
into the label box.

© Pinnacle Publishing, Inc.

Press F9 to return to the Print Options screen.
Set the report to print to disk, and justify the report
body left. Press F10 and assign a name to the
resulting disk file.
Convert the report to a two-column format
The report you just printed to disk is a one-column
layout. The next step is to convert it to a twocolumn layout. For this you need to treat the report
as a Write document.
From the Write menu, select Get, type in the
disk file’s name, and press Enter to bring it onto the
Type/Edit screen. Press Ctrl-F9 for the Font
Assignments screen and make a small monospaced
font, such as Line Printer, your default font. Press
F10 to return to the document screen.
Press Ctrl-F6 to define the page. Set the page
width and right margin at 140. Set your other
margins to 0. Set the page length between 55 (more
leading for fewer entries per page) and 80 (tighter
leading for more entries per page).

Press F10 and F2 for the Print Options screen,
set the Number of columns to 2, set Page Preview to
Yes if you want to see what the page will look like,
and press F10 to print. If the report prints too far to
the left on the page, return to the Print Options
screen, enter a value between 1 and 10 on the Print
offset line, and print the report again.
If the gap between the two columns (called the
gutter) is too large, you can reduce it at Write’s
Global Editing Options screen.
So there you have it—three ways to print
attractive and easy-to-read multicolumn lists. Once
you’ve become familiar with the tools and
techniques to achieve these feats, you can perform
all sorts of useful tricks with your output.
Tom Marcellus is editor of The Quick Answer, and the author
of PC World Q&A Bible, published by IDG Books, and The
Quick Answer Focus special report on monthly billing
statements, published by Pinnacle Publishing.

Create a Simplified Dot Leader Report
The two sample telephone lists I’ve shown include dot
leaders that extend from the end of the name and
department to the beginning of the phone number. You
can create a simplified dot leader report, such as the
one shown in Figure 4, with the leader extending only
to the end of each column. By minimizing the space
between the report columns (at the Report Global
Format Options screen), the dots will connect the
column entries except for the single space between the
columns.
Suppose the Company and Contact fields are both
30 characters wide, and you want to print a contact list

with dot leaders showing the company name, person
to contact, and phone number. You can use the
following Column/Sort Spec and two derived columns
to get the report shown in Figure 4:
Company: 1,I
Contact: 3,I
Phone: 5
Heading: Company
Formula: #1+@Text(30-@Len(#1),".")
Column Spec: 2,AS
Heading: Contact
Formula: #3+@Text(30-@Len(#3),".")
Column Spec: 4

If you don’t know the widths of the database fields,
you can replace the fixed 30 in the derived column
@Text functions with the variable @Width function.
The following derived column formula subtracts the
length of field #1’s value from the field’s width and fills
the remaining character spaces with dots:
Formula: #1+@Text(@Width(#1)-@Len(#1),".")

Figure 4. A portion of a simplified columnar
report with dot leaders.

© Pinnacle Publishing, Inc.

Should you want a different leader character—a dash,
for example—you can replace the period. (You can
choose an ASCII graphic character, if you like.) Q&A
will use whatever character you specify to connect the
entries.

The Quick Answer ▲ April 1995

5

Q&A won’t let you add records to a
database and have related records in
another database updated
simultaneously. Here’s how I worked
around this limitation.
I use an accounts payable database
(AP.DTF) that includes vendor name
and address data, in addition to
multiple general ledger account
number and amount fields. With this
database, I can record a payment to a
vendor along with the check number, and break the
payment down into several general ledger expense
accounts.
I also maintain a vendor information database
(VENDOR.DTF) that includes vendor name and
address data, along with the general ledger expense
accounts to which payments to this vendor
normally apply.
When entering payments in AP.DTF, I use the
vendor code to lookup the vendor’s name, address,
and general ledger account information from
VENDOR.DTF. This process went smoothly until I
had to pay a new vendor or some existing vendor’s
address or other basic information changed. At this
point, I had to quit AP, switch to VENDOR, add or
edit the information, and then switch back to AP to
continue. I decided to create a shortcut.
I added two new fields to the AP database: New
Vendor and Changed Info. During AP data entry, I
type an X in the New Vendor field if it’s a new
vendor, or an X in the Changed Info field for an
address or other change. I then type in the new or
changed information in the AP record.
After the AP session, I update the VENDOR file
using the Xs in these two new fields as retrieval
parameters.
For the AP records where the New Vendor field
is checked, I use Q&A’s Copy feature along with a
Merge Spec to create new prefilled records in the
VENDOR file.
For the AP records where the Changed Info field
is checked, I use Q&A’s Posting feature to update
the related VENDOR records with the changed
information.
I then run a Mass Update to clear the two fields
in the AP database so the same records can’t be
copied or posted again.
Of course, I use a macro to automate the
process. It’s designed to perform these steps.
To create new VENDOR records, do the
following:

6
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1. Run Copy from the File menu (from AP to
VENDOR).
2. Use a saved Retrieve Spec that includes the AP
records with an X in the New Vendor field.
3. Use a saved Merge Spec.
To update existing VENDOR records, do the
following:
4. Run Post from the File menu (from AP to
VENDOR).
5. Use a saved Retrieve Spec that includes the AP
records with an X in the Changed Info field.
6. Use a saved Batch Posting Spec. The VENDOR
records are now up to date with any address or
other changes.
To clear the New Vendor and Changed Info fields,
do the following:
7. Run Mass Update from the File menu.
8. Use a saved Retrieve Spec that includes the AP
records with an X in either the New Vendor or
Changed Info field.
9. Use a saved Update Spec that blanks both fields.
Now, when entering payments, I don’t have to
switch back and forth between the two databases. I
let Q&A do the work for me after the session.
John Kell, Schofield, Wisconsin

QUICKTIP

QUICKTIP

Save Time When Updating Related Records

Drawing Straight
Lines
When drawing lines on a form, you
can restrict the line to horizontal,
vertical, or 45 degrees by holding the
Shift key down while dragging the
line.
David Dvorin, Phoenix Solutions
Belle Mead, New Jersey

© Pinnacle Publishing, Inc.

@HELP

Edited by Dave Reid

Suppress Report
Columns

Q

I designed a Q&A report to place
the totals of a group of records
on the same line as the name of the
group. To do this, I used the technique
described in “Create Attractive
Summary Reports” in the July 1993 issue, but it
didn’t work as well as I had hoped. The totals
appear on the same line as the group name, but
Q&A still prints the individual group members on
the subsequent lines. Thankfully, the total line for
each member is suppressed, but how can I get rid of
their names?
Norman Zabb
West Palm Beach, Florida

A

It sounds like you’ve followed the instructions
in the article but you’ve missed a step. The
only columns you want to leave visible in your
report are the total columns, along with any
columns that define the groups, such as Department
Name. If you still get a column of names or
individual salaries, they need to be made invisible.
Simply add a comma and an I to the Column/Sort
Spec for those columns you want to remove. The
rest of the report won’t be affected.

Search for Non-Dates
in Date Fields

Q

I use Q&A 4.0 to track incoming shipments to
my office. When I order a product, I create a
record that identifies the Shipper and the Ship Date.
I also have a Date Received field, which I like to fill
with Not Yet until the shipment arrives. I don’t
mind that Not Yet isn’t a date and that I have to
press Enter twice to get Q&A to accept it. The
trouble comes when I try to retrieve records with
Not Yet in the Date Received field—Q&A won’t let
me do it. Any suggestions?
Grant Beech
San Jose, California

A

Q&A expects to see actual dates in fields
formatted for dates and doesn’t let you use text
values as retrieval parameters unless you override
the restriction with a special retrieval code. If Not
Yet is the only text value in the Date Received field,
you can use the following Retrieve Spec parameter:

© Pinnacle Publishing, Inc.

Date Received

/..

The /.. code tells Q&A that the value you’re
searching on isn’t properly formatted for the field,
and Q&A will retrieve all the records containing a
non-date value in the Date Received field. If you use
a variety of text values in the Date Received field,
such as Not Yet, Lost, and Returned, and you want
to search them individually, limit your retrieval
parameter to the specific value, like this:
Date Received

]Not Yet

The right bracket tells Q&A to treat the retrieval as if
Date Received were a text field. You can use this
approach with each of the text values to retrieve
only the records that contain the value you’re
looking for.

Print One Page
of a Lengthy Report

Q

I often print a 25- to 30-page report in Q&A
4.0. After printing the report, I read through it
before distributing it. Sometimes I spot an error, or
perhaps an address needs to be changed. I’d like to
correct the error and then reprint just the corrected
page. Unlike the word processor, I can’t specify
which page I want to print. Is there anything I can
do?
Virginia Meyer
St. Cloud, Minnesota

A

You can’t select which report pages to print
because Q&A compiles and prints the entire
report based on the records you’ve included at the
Retrieve Spec. However, if your records are sorted
by a unique value, such as a client ID number, you
can print the report again by retrieving just the
records on the page with the corrected error. Simply
note which clients are the first and last on the page,
and enter their IDs at the Retrieve Spec for the same
report, like this:
Client Number: >=23045..<=23102

Because you haven’t changed the Column/Sort
Spec, the selected records should fill the corrected
page just as they did in the original report. Be
aware, though, that you’ll need to manually control
the page number when printing a corrected page
because Q&A will think it’s page one of a new
report. To do this, you can type the page number in
the report header or footer—wherever the page
numbers appear in the rest of the report.
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Solve XLookup Problem

Q

I use Q&A to track customers and invoices,
and I’d like to use the last four digits of the
customer’s phone number as the customer
identifier. The following statement in my invoice file
is intended to look up the customer’s name on the
four-digit number in field #70:
XLookup("Client", #70, @Right("Phone",4),
"Name", #80)

However, I get the error message, Cannot find
external key field: hone. I don’t understand what’s
going on.
Ken Olsen
Mesa, Arizona

A

The problem is the statement’s third parameter,
@Right(“Phone”,4), which isn’t a valid external
key field name. Moreover, because the values in the
external key field are indexed, Q&A requires a
match on the whole value, not just its rightmost four
digits. The error message indicates what’s gone
wrong. Q&A is executing the @Right statement on
the word Phone, the rightmost four characters of
which are hone. So, Q&A looks for an external key
field named hone. Because no such field exists, the
XLookup fails. To solve the problem, add a Speedy
field to your customer file and program it to return
the last four digits of the phone number. Make it the
external key field in the XLookup statement, and
you’ll be in business.

6.1 for Windows documentation to see if they’re able
to open WordPerfect 5.1 for DOS documents.
Chances are they will.

Fix Blank Lines in
Address Blocks

Q

I use Q&A Write for Windows to mail merge
letters and envelopes with data from a Q&A
database. I noticed that when a record has no
company name, Q&A leaves a blank line in the
printed output. After checking the manual, I added
the Line Break (Shift-Enter) command to separate
the address lines. The letters now print without any
blank lines; however, the problem persists in the
envelopes. What gives?
Bill Syrios
Eugene, Oregon

A

I suspect that when you corrected your merge
letter by inserting the line breaks, you didn’t
do the same for the envelope. You can edit the
existing envelope to add the line breaks (as you did
in the document) by choosing Edit Envelope from
the Tools menu. When creating a new mail merge
document, type the address block with line breaks
the first time. When you design the envelope, select
the correctly typed address block, and choose Create
Envelope from the Tools menu. The address on the
envelope will then include the proper line breaks.

Automate Cursor Navigation
Converting Documents
to WordPerfect

Q

We need to convert documents between Q&A
4.0 and WordPerfect 5.1 and 6.0b for DOS and
WordPerfect 6.1 for Windows. Is there a trick we
don’t know about?
John Avers
Monticello, Indiana

A

Q&A converts Write documents to
WordPerfect 5.0 and 5.1 for DOS formats—
they’re on the Write / Utilities / Export menu.
Select WordPerfect and then select version 5.1.
Specify the document you want to export and assign
a new name to the converted document. Though
you can’t export to other versions of WordPerfect,
those versions will probably let you open
documents from earlier versions of the same
program. Check your WordPerfect 6.0b for DOS and

8
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Q

I use a database to record transactions. The
operator enters individual transactions in
fields in an area near the top of the form and then
transcribes the data into fields in a log area on
subsequent pages. The log area is made up of 38
fields to store the information transcribed from the
upper-area fields. When the operator finishes
entering a transaction in the upper area, I’d like
Q&A to automatically move the cursor to the next
available line in the log area. How can I do this?
Rick Elias
Brooklyn, New York

A

I suggest you add a field near the bottom of
the form to hold a line counter. Program it so
that when the operator exits the last field in the
upper area, Q&A executes the program in the
counter field to place the cursor in the next available
empty line in the log area. Use a program such as
this in the last field of the upper area:

© Pinnacle Publishing, Inc.

>Gosub Counter; Goto @("Date"+Counter)

The program begins by executing the program in
the Counter field and then moves the cursor to the
Date field referenced by the Counter field. (The
program assumes that the 38 Date fields are named
Date1 through Date38. To change your field names
to match these, use the Field Names Spec.) The
Counter field program determines the next available
blank line as follows:
<If Counter = "" Then Counter = 1;
If @("Date"+@Str(Counter-1)) = "" AND Counter > 1
Then {
Counter = Counter - 1;
Goto Counter
};
If @("Date"+@Str(Counter)) = ""
Then Return
Else {
Counter = Counter + 1;
Goto Counter
}

The first If-Then statement initializes the blank
Counter field. The second If-Then statement checks
to see if the previous line in the log area is blank. If
it is, the program decrements the Counter and loops
back to Counter to check again. (This case isn’t
likely to occur, but it makes the program more
robust because it helps prevent skipped lines if the
counter field somehow gets set too high.) The final
If-Then-Else statement checks the Date field for the
current line and, if it’s blank, returns control to the

upper area. But if the Date field isn’t blank, it
increments Counter and loops back to Counter.
You might be able to take advantage of similar
programming to automatically transcribe and fill-in
the pertinent line in the log area, which might prove
a more productive long-term solution.
Dave Reid is a Symantec senior support analyst providing
second- level assistance to the technical support representatives.
He’s also the coauthor of The Q&A 4.0 Wiley Command
Reference, published by John Wiley and Sons, and works as an
independent Q&A consultant. PO Box 12083, Eugene, OR
97440.
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Have a nagging question? Send
it to @Help, The Quick Answer,
PO Box 888, Kent, WA 980350888 or fax to 206-251-5057.
When writing, please include
your name, address, and phone
number, along with your Q&A
version number (and whether
DOS or Windows), and a
detailed description of the
problem. We will publish those
questions we feel are of general
reader interest; individual
responses are not possible.

QUICKTIP

See Your Forms for a Change
Q&A/Windows default data entry
forms can be hard on the eyes for
three reasons:
• The field labels and data appear in
the same font, sometimes making it
hard to differentiate between the
two.
• The font size can be too small,
forcing you to strain to see your
data.
• The fields can be too close to each other,
compounding the problem.
You can make your data entry forms easier to see
and work with by making a few of quick changes.
First, add more “white space” between the
fields on the form. Click on the Select menu, click on
Design input forms, and choose the form you want to
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work with. Start with the fields at the bottom of the
form. Click on a field to select it, press Shift, and
click on its label. You can now work with the field
and its label as if they were a single object. Click and
drag the field and label to a new position farther
away from the surrounding fields. Do the same for
the other fields and labels until you’ve achieved
enough “white space” between the fields to make
the form visually appealing.
Next, assign a larger and bolder font to your
data values to make them distinctive. If they’re in
the default 8 point regular font, make them 10 point
boldface. To do this, click on a field (the information
blank, not the label) to select it, click on the Format
menu, click on Font, click on Bold in the Font Style
column, click on 10 in the Size column, and then
click OK. Do the same for each field in turn.
When you’re finished, your field labels and
data, and the overall form, will be easier to read.
Tom Marcellus
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Create an Employee
Scheduling System
If your business requires advance employee scheduling, Q&A makes
it a snap to keep tabs on who’s assigned to work when, and helps you
predict labor costs and get valuable payroll information, to boot.

By William Halpern

A

large retail bakery asked me to design a
flexible and easy-to-use employee
scheduling system. With minimal additional
work, I was able to include hourly and weekly
timekeeping and budgeting capabilities in the
application as well.
The application called for two databases and a
couple of key reports. One of the reports, a portion
of which is shown in Figure 1, is posted at the
workplace to show employees their hourly
schedules for the week. Another report (see Figure
2) provides the client with a summary of weekly
scheduling. I’ll describe the databases and reports
that make up the system. (The report designs are
particularly instructive in that they required rather
sophisticated derived column techniques to achieve
the layout the client wanted.) An application such as
this could be used by a retail outlet, a rental agency,
a restaurant, a repair shop, and so forth—wherever
employee work schedules can vary from week to
week.
Scheduling database
The main database is the employee scheduling file,
named SCHEDULE.DTF. Figure 3 shows a typical
SCHEDULE record, and Figure 4 shows the form

Figure 1. Portion of a weekly employee schedule,
showing each employee’s starting and quitting
times, with totals by employee and department.
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layout. The form includes separate sections for
hours scheduled and hours worked. Many of
SCHEDULE’s fields don’t include field labels, and
the columnar field arrangement for in and out times
and total hours makes it easy to enter and view the
data. Each weekday In and Out field is formatted
for time values in the military style, and each daily
Total field is formatted numbers.
To make data entry flow logically, form
navigation commands in the Navigation Spec
ensure that the cursor moves vertically down the
daily columns, allowing both the In and Out times
to be filled in for the day. The commands then move
the cursor to the subsequent day.

Figure 2. Portion of the summary report of
scheduled hours by department. It looks like a
crosstab, but it’s a columnar report.

Figure 3. Typical employee scheduling record.
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Employee database
To complement the application and to enable cost
budgeting and payroll calculations, I needed a
database to store employee information. (See Figure
5.) The Payroll Number field, which is the
employee’s ID, must be Speedy and Unique. The
Start, Max, and Current Salary fields store the
employee’s starting, maximum, and current pay
rates.
The SCHEDULE database’s programming and
reports are what make the application easy to use.
The programming performs operations and
calculations specific to my client’s needs, so I’ll
follow the programming statements with an
explanation of what each one accomplishes. You can
then make whatever programming modifications
are appropriate for your system:
Week of: >#10:
If #10="" Then{
If @Dow$(@Date)="Monday" Then #10=@Date+7;
If @Dow$(@Date)="Tuesday" Then #10=@Date+6;
If @Dow$(@Date)="Wednesday" Then #10=@Date+5;
If @Dow$(@Date)="Thursday" Then #10=@Date+4;
If @Dow$(@Date)="Friday" Then #10=@Date+3;
If @Dow$(@Date)="Saturday" Then #10=@Date+2;
If @Dow$(@Date)="Sunday" Then #10=@Date+1}
Employee Number: >#20:
If #20="" Then {@Msg("This Field Requires a Value
- Please Enter");
Goto #20}; If #30="" Then {
#30=@Xlu("Employee",#20,"Pay Num","First Name")
+" "+
@Xlu("Employee",#20,"Pay Num","Last Name");
Xlu("Employee",#20,"Pay Num","Str/Dept",#40,
"Current Salary", #50)};
If @Error Then {@Msg("This Employee Number Is Incorrect
- Please re-Enter"); Goto #20}
Employee Name: <#30: cnext
Employee Dept: <#40: cnext
Pay Rate: <#50:cnext

Assign the following seven field ID numbers to the
In fields in the Hours Scheduled section of the form
(Monday through Sunday, respectively):

Assign the following seven field ID numbers to the
Out fields in the Hours Scheduled section of the
form (Monday through Sunday, respectively):
#61, #71, #81, #91, #101, #111, #121

Assign the following seven field numbers and
programs to the Total hours fields in the Hours
Scheduled section of the form (Monday through
Sunday, respectively):
#62=(#61-#60)/60
#72=(#71-#70)/60
#82=(#81-#80)/60
#92=(#91-#90)/60
#102=(#101-#100)/60
#112=(#111-#110)/60
#122=(#121-#120)/60

Here’s the formula for Total Scheduled Hours:
#130=@Sum(#62,#72,#82,#92,#102,#112,#122)

Here’s the formula for Total Scheduled Wages:
#140=#130*#50

The weekly schedule is prepared during the week
previous to the effective week, and the
programming is designed to automate the data
entry. Accordingly, the first statement in the Week
Of field checks to see what day of the week the
current day is, and sets Week Of to the date of the
following Monday. Programming execution takes
place on field exit only if the Week Of field is empty.
You can also make simple program modifications to
create a two-week advance schedule, begin the work
week on Sunday, and so forth.
The program in the Employee Number field
looks up the employee’s name, department, and
current pay rate from the related EMPLOYEE record
on entry of a valid employee ID. To speed data entry
and avoid errors, you can use a Restricted Values list

#60, #70, #80, #90, #100, #110, #120

Figure 4. Employee scheduling form layout.
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Figure 5. Typical employee record.
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in this field to display employee names and ID
numbers.
Because of the sensitive nature of the data in the
EMPLOYEE file, you’ll probably want to password
protect it, preventing unauthorized users from
accessing it. If you password protect EMPLOYEE,
you must then set an XLookup password for
SCHEDULE to allow SCHEDULE’s programming to
perform XLookups to EMPLOYEE. You can do this
via the File / Design / Security menu. If the person
who prepares the weekly schedule is authorized to
access the EMPLOYEE file, you can use that
person’s User ID and password.
The programs in the total hours fields for
Monday through Sunday subtract the starting time
from the ending time and divide the difference in
minutes by 60 to return the number of hours
scheduled for each day.
The program for the Total Scheduled Hours
field simply adds the daily hours totals. The
program in the Total Scheduled Wages field
multiplies the total hours by the employee’s hourly
rate and is helpful for estimating labor costs for the
coming week.
You can use the same programming for the
fields in the Hours Worked section of the form (the
bottom half of the form) to calculate the actual
worked hours and the actual gross pay.
The employee schedule report
The real power of the SCHEDULE database is in the
informative reports it makes possible. The key to the
employee scheduling report in Figure 1 is in using
derived columns to make it look like a schedule
rather than a bunch of columns.
To design the report, choose Report from the
Main menu, and then choose Design/redesign a
report for the SCHEDULE database. Name the

Figure 6. Column/Sort Spec for the Employee
Weekly Schedule report. Figure 1 shows the
output you can expect.
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report Employee Weekly Schedule, and confirm that
it will be a columnar report.
For now, leave the report Retrieve Spec blank,
and press F10 to display the Column/Sort Spec.
Type in the specs for each column as shown in
Figure 6. The I command included in each column’s
spec tells Q&A to make the column invisible. This
way, you can use the data in the derived columns
that I’ll show you next.
With the Column/Sort Spec completed, press F8
to display the derived column screen. Type in the
Headings, Formulas, and Column Specs as follows
(some of the formulas are shown here on two lines
for space reasons):
Heading: Spaces
Formula: @Txt(25," ")
Column Spec: 1,I
Heading: 25:Name!Emp Numb!Week
Formula: @Str(#38)+#1+@Str(#36)+#1+@Str(#99)
Column Spec: 39
Heading: Dept
Formula: @Rt(#30,3)
Column Spec:35,AS,STL(Dept Tot)
Heading: 6:Monday!In/Out!Total
Formula: @Str(#40)+#1+@Str(#41)+#1+@Str(#42)
+#1+@Txt(6,"-")
Column Spec: 65
Heading: 6:Tues!In/Out!Total
Formula: @Str(#50)+#1+@Str(#51)+#1+@Str(#52)
+#1+@Txt(6,"-")
Column Spec: 70
Heading: 6:Wed!In/Out!Total
Formula: @Str(#80)+#1+@Str(#81)+#1+@Str(#82)

Use Automatic
Calculation for
SCHEDULE’s
Programming
SCHEDULE’s programming is simple enough that
you can use Automatic Calculation mode and avoid
on-field-entry and on-field-exit commands. Automatic
Calculation mode will execute the programming
statements whenever there’s a change to any field.
This means the programs are recalculated when you
enter the starting time for any day. The totals fields
may even show negative numbers, but Q&A will fill
the them with the correct numbers once you’ve
entered the ending times. To set the database to
Automatic Calculation mode, display a record in
either Search/Update or Add Data, press Shift-F8,
set the Calculation mode to Automatic, and press
F10. You only have to do this once.
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+#1+@Txt(6,"-")
Column Spec: 85
Heading: 6:Thurs!In/Out!Total
Formula: @Str(#90)+#1+@Str(#91)+#1+@Str(#92)
+#1+@Txt(6,"-")
Column Spec: 95
Heading: 6:Fri!In/Out!Total
Formula: @Str(#100)+#1+@Str(#101)+#1+@Str(#102)
+#1+@Txt(6,"-")
Column Spec: 105
Heading: 6:Sat!In/Out!Total
Formula: @Str(#110)+#1+@Str(#111)+#1+@Str(#112)
+#1+@Txt(6,"-")
Column Spec: 115
Heading: 6:Sun!In/Out!Total
Formula: @Str(#120)+#1+@Str(#121)+#1+@Str(#122)
+#1+@Txt(6,"-")
Column Spec: 125

The first derived column is invisible. Its formula
creates a string of 25 spaces, which force the
information in any subsequent columns that
reference it to wrap properly. This way, you can
force the Employee Name, Employee Number, and
Week Of fields (#38, #36, and #99) into a single
column by restricting the column’s width and
adding the spaces. In other words, by placing the
first derived column (#1) between the three fields
(see the second derived column for an example of
this), you can make a MARK ACKERMAN 003001
1994/10/17 string appear in the report like this:
MARK ACKERMAN
003001
1994/10/17

Remember to fix the column width at 25 by making
the column Heading start with 25:.
The department numbers the client uses are a
combination of the employee’s department and ID

Figure 7. Column/Sort Spec for Department
Weekly Report. Figure 2 shows the kind of output
you can expect.

number. (See Figure 3.) The third derived column
causes Q&A to return the rightmost three characters
of the department number and sort the report by
department. You can omit this derived column if
you’re using a straight department number, but be
sure to change the Column/Sort spec for the
Department field to 30,AS,STL(Department Total).
Don’t forget the STL(Department Total) because this
is what changes the subtotal label from Total to
Department Total to avoid confusion when reading
the report.
The fourth through tenth derived columns print
the daily work schedules in a vertical format that
includes the starting time, the ending time, and the
scheduled hours, like this:
12:00
18:00
6
------

QUICKTIP

Print a Q&A for DOS Screen in Windows
Although you can print out most
Q&A/DOS specs, sometimes it’s
handier to perform a screen print by
pressing the Print Screen key. When
running Q&A/DOS under Windows,
however, pressing the Print Screen key
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copies the screen to the Windows Clipboard
instead of printing it out. To print a hard
copy of the active window, press Shift-Print
Screen instead.
Alec Mulvey, Ascot, England
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The first derived column is again referenced in each
of these subsequent derived columns whose widths
are restricted to six characters. This way, the starting
time, the ending time, and the total hours for each
day can be combined into a string and then
wrapped onto separate lines. To get the dashed line
under each set of numbers, the formulas reference
the first derived column and add six dashes to the
end of each string via the +#1+@Txt(6,"-") part of the
expression.
The schedule summary report
Now, let’s look at the design elements of the
schedule summary report shown in Figure 2. The
approach is the same as in the previous report
because you want the data presented in a custom,
easy-to-read layout. Accordingly, you’ll need to
place most of the data in derived columns and use
the @Total command to have Q&A summarize it.
Design a new report named Department Weekly
Schedule and tell Q&A that it’s a columnar report.
For the moment, leave the Retrieve Spec blank, and
press F10 to display the Column/Sort Spec. Type in
the specs for each of the columns using Figure 7 as
your guide.
Next, create the requisite derived columns to
format and summarize the data. Type in the
Headings, Formulas, and Column Specs as shown
here:
Heading: Dept
Formula: @Rt(#5,3)
Column Spec: 8,AS
Heading: Dupd Dep
Formula: #8
Column Spec: 300,I
Heading: 8:Monday!Dept!Hrs
Formula: @Txt(#300<>#8,@Tot(#10,#8))
Column Spec: 15,F(JC),T
Heading: 8:Tues!Dept!Hrs
Formula: @Txt(#300<>#8,@Tot(#20,#8))
Column Spec: 25,F(JC),T
Heading: 8:Wed!Dept!Hrs
Formula: @Txt(#300<>#8,@Tot(#30,#8))
Column Spec: 35,F(JC),T
Heading: 8:Thurs!Dept!Hrs
Formula: @Txt(#300<>#8,@Tot(#40,#8))
Column Spec: 45,F(JC),T
Heading: 8:Fri!Dept!Hrs
Formula: @Txt(#300<>#8,@Tot(#50,#8))
Column Spec: 55,F(JC),T
Heading: 8:Sat!Dept!Hrs
Formula: @Txt(#300<>#8,@Tot(#60,#8))
Column Spec: 65,F(JC),T
Heading: 8:Sun!Dept!Hrs
Formula: @Txt(#300<>#8,@Tot(#70,#8))
Column Spec: 75,F(JC),T
Heading: Tot!Dept!Hrs
Formula: @Txt(#300<>#8,@Sum(#15,#25,#35,
#45,#55,#65,#75))
Column Spec: 200,T
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The first column performs the same function as the
Department column in the previous report. If you
have a straightforward Department field in your
database, you can omit this derived column and use
an 8,AS Column/Sort spec in the Department field.
The key to this summary report is in the second
derived column. It’s a hidden copy of the
Department column and the final column in the
report. By having Q&A compare the value in this
column with the value in column 8, you can control
when to print or calculate other derived columns in
the report. The @Txt(#300<>#8, command) formula
tells Q&A to execute command only when the value
in the duplicate department column (#300) doesn’t
match the value in the Department column (#8).
Because Q&A processes column entries from left to
right, the expression will be true for each record
where the department differs from the previously
processed record, and Q&A will execute the
conditional @Total command. This illustrates the
importance of sorting the report by department.
The third through ninth derived columns
calculate the hours total for each day of the week
based on a break in Department and print them only
when the Department changes.
The 10th derived column sums the daily
derived columns and prints the total each time the
Department changes. Keeping in mind Q&A’s
report calculation sequence, it’s vital that the
column numbers are in the proper order.
When printing these reports, be sure to confirm
that you want to make temporary changes so you
can enter the appropriate date in the Week Of field
at the Retrieve Spec.
Conclusion
You now have the elements of an employee
scheduling system that includes timekeeping and
budgeting features. You can, of course, make
database design and programming changes, and
create any additional reports you might need. For
example, you could redesign the database to
accommodate two-week advance scheduling
requirements, calculate regular and overtime pay
for different classes of employees (salaried, hourly,
and daily), create an employee phone book, track
employee work and pay history, and generate
reports for payroll or outside payroll services.
Bill Halpern is executive vice president of Professional
Computer Technology Associates in Newtown, Pennsylvania,
and author of Pinnacle Publishing’s The Quick Answer Focus
special report on Macros and Custom Menus. Bill has been
designing and installing Q&A business applications for the
past eight years, and teaches Q&A at two community colleges.
215-968-4185, CompuServe 71023,356.
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QUICKTIP

Get Better Screen Prints
If you’re using an HP LaserJet, and
your print screens (when you press
the Print Screen key) are printing with
odd ASCII characters instead of the
lines and boxes on the screen, use the
printer’s control panel to select the
PC-8 Symbol Set. This internal HP
character set includes the line and box
ASCII characters, and allows you to
print a true copy of your screen.
To select the PC-8 Symbol Set on an
HP LaserJet 4P, for example, press the On Line key
to take the printer off line. Next, press the Menu key

twice to select the PCL menu, press the Item key
four times to display SYM SET=PC-8, and press the
Enter key (on the printer) to select it. Press the On
Line key to place the printer back on line, and print
your screen.
If the cursor doesn’t race down the screen when
you press Print Screen, press it a second time (or
press Shift-Print Screen instead). If the Form Feed
light on the control panel lights up but the page
doesn’t feed, press On Line, Form Feed, and On
Line again.
Tom Marcellus

QUICKTIP

Cut and Paste with the Mouse
Q&A for DOS doesn’t have a mousedriven cut and paste feature, but you
can add it to Q&A Write with two
simple macros. To create the cut
function, start the macro recorder, set
the macro identifier to Alt-C (for cut),
press F3, end recording, and name the
macro Cut. Create the paste macro the
same way, except assign it the Alt-P
key identifier (for paste). Press
Shift-F7, and name the macro Paste.

Here’s what the two macros look like in Write:
<begdef><altc><name>"Cut"<vidoff><f3><enddef>
<begdef><altp><name>"Paste"<vidoff><capsf7><enddef>

To use your new feature, highlight some text with
the mouse, click the right mouse button to display
the Macro List, and click on Cut. Position the cursor
where you want to paste the text, click the right
mouse button, and click on Paste.
David Dvorin, Phoenix Solutions, Belle Mead, New Jersey

QUICKTIP

Lengthen, Shorten, or Expand a Field
You can quickly lengthen, shorten, or
expand a field’s information blank on
a data entry form. To do so, choose
Design input form from the Select
menu, and click on the form you want
to work with. With the form
displayed, click on a field’s
information blank to select it. Q&A
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outlines the field, and places a solid block (called an
anchor) at each corner of the outline. Move the
pointer to the lower right block until the double
arrow appears. Drag the block to the right to
lengthen the field, drag it to the left to shorten it, or
drag it downward to expand it.
Tom Marcellus
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QUICKTIP

Add a “Secret” Field to Your Form
Suppose you want to add private
comments to some of your records but
you don’t want to hassle with
password protecting the database,
creating a hidden field, and so forth.
You can add a couple of fields to your
form, and program them to allow
access to the secret field only when
the password field contains the
correct password.
If your data entry form consists of
one page, make the password field the last field on
that page, and the secret field the first and only field
on the second page. Program the password field as
follows:
< Clear(Password); @Msg("Enter your password
to access page 2")

This statement clears the field named Password and
displays a message prompting you to enter your
password.

Program the secret field like this:
< If Password <> "Sharky" then
{@Msg("Valid password not entered. Try again");
Clear(Password);
CPrev}
Else Clear(Password)

This statement checks to see if the Password field
contains Sharky (use whatever password you want).
If it does, the password is cleared and the field
named Secret is displayed. Otherwise, the password
is cleared and you’re prompted to try again.
As long as the secret field is the only field on the
second page, it can’t be reached during Add Data or
Search/Update without the proper password.
Someone could, however, find out what’s in it by
including it in a report. And they could see its first
14 characters if it were included in a Table View.
If the information in the field is highly sensitive,
it merits going to the trouble of password protecting
the database and hiding the field. That way, only
users with the proper access can see and edit it.
Tom Marcellus

Printed in the U.S.A on recycled paper.

Pinnacle Publishing, Inc.
PO Box 888
Kent, WA 98035-0888
206-251-1900
206-251-5057 (fax)

Second-Class
Postage Paid at
Kent, WA

16

The Quick Answer ▲ April 1995

© Pinnacle Publishing, Inc.

